Ladder Editor for FS100
Operator’s Manual

Upon receipt of the product and prior to initial operation, read this instruction thoroughly, and retain for future reference.
General Precautions

- Diagrams and photos in this manual are used as examples only and may differ from the actual delivered product.

- This manual may be modified when necessary because of improvement of the product, modification, or changes in specifications. Such modification is made as a revision by renewing the manual No.

- To order a copy of this manual, if your copy has been damaged or lost, contact your YASKAWA representative listed on the last page stating the manual No. on the front page.

- YASKAWA is not responsible for any modification of the product made by the user since that will void our guarantee.

- Software supplied with this manual is intended for use by licensed operators only and may only be used or copied according to the provisions of the license.

- Reproduction of any part of this manual without the consent of YASKAWA is forbidden.

Copyright: YASKAWA ELECTRIC CORPORATION, 2008

Trademark

MS Windows 2000/XP/7 are registered trademarks of Microsoft Corporation, U.S.A. Ladder Editor for FS100 is a trademark of YASKAWA.
CONTENTS

1 INTRODUCTION .......................................................................................................................... 7
  1.1 Hardware Requirements for Ladder Editor for FS100 ............................................................ 7
  1.2 Ladder Editor for FS100 ........................................................................................................ 7
    1.2.1 What is Ladder Editor for FS100? ................................................................................. 7
    1.2.2 Features of Ladder Editor for FS100 ............................................................................. 7
  1.3 Terms ..................................................................................................................................... 9

2 Installation .................................................................................................................................. 10
  2.1 Installing Ladder Editor ......................................................................................................... 10
  2.2 Installing the Hardware Key .................................................................................................. 10

3 LADDER EDITOR FOR FS100 BASIC DISPLAY .................................................................... 11

4 FLOWCHART OF BASIC EDITING ...................................................................................... 12

5 STARTING AND ENDING LADDER EDITOR FOR FS100 .................................................. 13
  5.1 How to Start ......................................................................................................................... 13
  5.2 How to End .......................................................................................................................... 15

6 READING AND STORING EDITED LADDER FILES .............................................................. 16
  6.1 Reading Ladder Data ............................................................................................................ 16
  6.2 Reading Several Ladder Files .............................................................................................. 17
  6.3 Storing Edited Data ............................................................................................................... 18
    6.3.1 Storing when a Ladder Program File (CIOPRG.LST) is Open .................................... 18
    6.3.2 Storing a Ladder Program that is Being Edited ............................................................ 18

7 CREATING A LADDER DIAGRAM .......................................................................................... 19

8 EDITING A LADDER DIAGRAM ............................................................................................. 20
  8.1 Ladder Parts Specifications ................................................................................................. 20
  8.2 Selecting a Ladder Edited Line ............................................................................................ 20
  8.3 Adding New Ladder Parts .................................................................................................... 21
  8.4 Deleting Ladder Parts .......................................................................................................... 22
  8.5 Connecting and Disconnecting Lines between Ladder Parts ............................................ 22
    8.5.1 Connecting with a Line .................................................................................................... 22
    ■ Ladder Parts Connection Terminals .................................................................................. 23
    8.5.2 Disconnecting Two Parts ............................................................................................... 24
  8.6 Setting Relay No., Register No. and Constants ................................................................... 25
    8.6.1 Setting Values Using a Pop-up Menu .......................................................................... 25
  8.7 Inputting Relay No. and Register No. Names ........................................................................ 26
    8.7.1 Setting Names Using a Pop-up Menu .......................................................................... 27
  8.8 Inserting Editing Matrix Row and Line ................................................................................ 28
8.8.1 Inserting a Row ................................................................. 28

- Row Insertion Disabled Pattern ............................................... 29

8.8.2 Inserting a Line ............................................................... 29

- Line Insertion Disabled Pattern ............................................. 30

8.9 Deleting Editing Matrix Row and Line .................................... 31

8.9.1 Deleting a Row ............................................................... 31

8.9.2 Deleting a Line ............................................................. 31

8.10 Clearing Displays ............................................................ 32

9 INSERTING A NEW LINE .......................................................... 33

10 LINE OPERATION OF LADDER DIAGRAM ............................ 34

10.1 Changing an Edited Ladder Line ......................................... 34

10.2 Inserting an Edited Ladder Line ......................................... 34

11 CUTTING, COPYING AND PASTING LINES ............................ 35

11.1 Cutting a Ladder Diagram Line .......................................... 35

11.2 Copy a Ladder Diagram Line ............................................. 35

11.3 Pasting a Ladder Diagram Line .......................................... 35

11.4 Inserting and Pasting a Ladder Diagram Line ....................... 36

12 COMPILING EDITED CONTENTS .............................................. 37

13 PRINTING ............................................................................ 38

13.1 Printing a Ladder Diagram .................................................. 38

13.2 Printing Relay No. Using List ............................................. 39

13.3 Printing Register No. Using List ......................................... 40

13.4 Printing Relay No. Use State .............................................. 41

13.5 Printing User Alarms and User Messages ............................. 42

13.5.1 User Alarm System Section and User Section .................. 44

13.5.2 User Alarm Selection Relay No. Information .................. 44

13.5.3 User Alarm Display Relay No. Information ..................... 44

14 TRANSFERRING PRINTING INFORMATION TO A TEXT FILE .... 45

14.1 Transferring Ladder Diagrams to a Text File ....................... 45

14.2 Transferring Used Relay No. Lists to a Text File .................. 45

14.3 Transferring Used Register No. Lists to a Text File .............. 45

14.4 Transferring Relay No. Use State to a Text File .................. 45

14.5 Transferring User Alarms and User Messages to a Text File ... 45

15 HEADER INFORMATION ..................................................... 46

15.1 Ladder Name and System Register Editing .......................... 46

16 USER ALARM AND USER MESSAGE INFORMATION .................. 47

4/88
16.1 User Alarm and User Message in System Section ..................................................47
17 SYSTEM LADDERS AND USER LADDERS .................................................................48
18 NAME FILE ..............................................................................................................49
  18.1 What is a Name File? ..........................................................................................49
  18.2 Reading Name File .............................................................................................49
    18.2.1 Reading Name File Automatically (With Name File) ....................................49
    18.2.2 Reading Name File Automatically (Without Name File) ............................50
  18.3 Storing Name File ...............................................................................................51
  18.4 Name Template File ...........................................................................................52
19 RELAY/REGISTER NAME LIST DISPLAY FUNCTION ...........................................53
20 LINE JUMP FUNCTION ............................................................................................55
  20.1 Line No. Search Jump .........................................................................................55
  20.2 Parts Set Value Search Jump ............................................................................55
    20.2.1 Previous/Next Search Jump ........................................................................56
  20.3 OUT Parts Relay No. Search Jump ......................................................................56
  20.4 History Jump ......................................................................................................57
21 CROSS REFERENCE FUNCTION ..............................................................................58
  21.1 Ladder Parts Set Value and Reference Line List Display Function ................58
    21.1.1 Line Jump from [Instruction Use Table] Dialog Box ..................................59
    21.2 Function to Display the Relay No. Use Table and Register No. Use Table .60
    21.2.1 Line Jump from [Relay Use Table] Dialog Box ..........................................63
22 Mnemonic Display Function ....................................................................................64
  22.1 Mnemonic Editing Function ..............................................................................64
23 OTHER SETTINGS .......................................................................................................66
  23.1 Setting Color .....................................................................................................66
  23.2 Setting Font ........................................................................................................67
  23.3 Automatic Storing Function of Name File ..........................................................67
  23.4 Automatic Rough Draft File Storing Function ...................................................68
  23.5 Automatic Backup Function of the Read-in File (Original File) .......................68
  23.6 Rough Draft File Forced Output Function .........................................................69
  23.7 Automatic Updating Function ..........................................................................69
  23.8 Switching Short Name Display/Non-Display .....................................................70
  23.9 File Settings ......................................................................................................71
24 CHANGING USER ACCOUNT LEVEL ....................................................................73
25 USER INFORMATION MANAGEMENT ..................................................................74
  25.1 How to Manage User Account .........................................................................74

5/88
25.2 Difference Depending of the Account Levels .......................................................... 75
25.3 Adding/Changing the User ..................................................................................... 77
26 APPENDIX .................................................................................................................. 78
26.1 Description of Menu .............................................................................................. 78
26.2 Description of Tool Bars ......................................................................................... 84
   26.2.1 Main Tool Bar .................................................................................................. 84
   26.2.2 Parts Control Tool Bar ..................................................................................... 85
   26.2.3 Search Jump Tool Bar ..................................................................................... 86
   26.2.4 Ladder Parts Tool Bar ..................................................................................... 87
26.3 Name File Format .................................................................................................... 88
1 INTRODUCTION

1.1 Hardware Requirements for Ladder Editor for FS100

Ladder Editor for FS100 operates with the configurations shown below.

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>OS</td>
<td>Japanese Microsoft Windows 2000 / XP(32-bit) / 7(32-bit)</td>
</tr>
<tr>
<td>Required Memory</td>
<td>16 Mbytes or more</td>
</tr>
<tr>
<td>CPU</td>
<td>Pentium or Pentium compatible processor</td>
</tr>
<tr>
<td>Hardware Disk Capacity for Installation</td>
<td>10 Mbytes or more</td>
</tr>
<tr>
<td>Disk Drive</td>
<td>Hard disk drive and CD-ROM drive</td>
</tr>
<tr>
<td>Display</td>
<td>Supported by MS-Windows</td>
</tr>
<tr>
<td>Mouse</td>
<td>Supported by MS-Windows</td>
</tr>
<tr>
<td>Robot Controller</td>
<td>FS100</td>
</tr>
<tr>
<td>Hardware Lock Key</td>
<td>Used under single user environment. For details, refer to the following section “Hardware Lock.”</td>
</tr>
</tbody>
</table>

Note: A personal computer and OS are not included with this software.

Table 1.1 Hardware Requirements for Ladder Editor for FS100

For FS100 concurrent I/O, refer to the FS100 Concurrent I/O

1.2 Ladder Editor for FS100

1.2.1 What is Ladder Editor for FS100?

The robot controller (FS100) has a concurrent I/O function that processes I/O related control independently from the manipulator, and in parallel with the manipulator operation. Ladder Editor for FS100 software is used to graphically display ladder programs with the above function as a signal connection diagram, or to edit ladder programs easily such as pasting command parts by a drag-and-drop operation using the mouse.

1.2.2 Features of Ladder Editor for FS100

- Ladder mnemonic code can be edited with an image of a ladder diagram.
• With the “ladder preview” display, the entire line of the ladder program can be easily previewed.

• Simple drag and drop operation can edit connections between ladder parts.

• Cross reference function is enriched.
  Information such as relay No. use state or the place where an arbitrary relay No. is used can be referenced easily.

• History jump function is available.
  This function records the history of jumping to other lines, and easily returns to the previous line before jumping.

• Printing function is enriched.
  Cross reference information can also be printed, as well as ladder diagrams.
  This function is very useful when a created ladder is stored as reference material.

• Print images are stored in the text file.
  Print images obtained by printing ladder diagrams can be stored in the text file. This function is useful when the data is filed and stored as an electronic document.
### 1.3 Terms

The following terms are frequently used in this manual.

<table>
<thead>
<tr>
<th>Terms</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ladder Parts</td>
<td>Object of matrix composing a ladder program such as STR, TMR or GRP</td>
</tr>
<tr>
<td>Set Value</td>
<td>Value set to ladder parts such as relay numbers, register numbers or constants</td>
</tr>
<tr>
<td>Line</td>
<td>One line indicates one section divided with OUT codes in a ladder mnemonic. Normally, there is one OUT part per line (excluding when GRP parts are used).</td>
</tr>
</tbody>
</table>
2 Installation

2.1 Installing Ladder Editor

Ladder Editor for FS100 is part of the MotoSoft family of software solutions. The Ladder Editor package is included in the provided Motoman Software Browser DVD (P/N: 141720-1).

Ladder Editor is installed by default under the Motoman program manager group.

Windows XP (32 bit): C:\Program Files\Motoman\Ladder Editor FS100\n
Windows XP (64 bit): C:\Program Files (x86)\Motoman\Ladder Editor FS100\n
Windows 7: C:\Users\Public\Motoman\Ladder Editor FS100\n
To install Ladder Editor, proceed as follows:

1. Insert the Motoman Software Browser DVD into the DVD drive.
2. The set-up program executes automatically and the introduction screen appears.

**NOTE**
Set-up executes automatically when the dvd is inserted into the DVD drive unless autoexecute has been disabled on your computer. If the set-up program does not autoexecute, double click the autorun.bat file.

3. Click the “Editor Software” link. The list of controllers appears.
4. Click the “FS100 Controller” link. The list of editor software appears.
5. Click the “Ladder Editor for FS100” link to begin installation. The Ladder Editor FS100 install wizard begins.
6. Follow the Ladder Editor FS100 install wizard instructions as it guides you through the installation process.

2.2 Installing the Hardware Key

A hardware key is supplied with Ladder Editor and must be attached to your computer’s USB port. Otherwise, Ladder Editor will not function properly. If multiple USB keys are in use, a USB hub can be used to expand the number of available USB ports. If you have difficulties using multiple SB hardware keys, contact Motoman customer service at (937) 847-3200.
3 LADDER EDITOR FOR FS100 BASIC DISPLAY

The following shows the “basic” display of Ladder Editor for FS100. The “basic” display is divided into two displays: “ladder preview” display and “ladder editing” display. Editing is available as referring to the ladder image before and after the ladder diagram in the editing line.

![Diagram of Ladder Editor for FS100]

**Fig. 3-1 “Basic” Display**
The following shows the basic flowchart of ladder editing.

Get a ladder program file from the FS100.

Start up the Ladder Editor 32 for FS100.

Open the ladder program from [file] - [Open] menu.

Editing the system ladder?

No

Select the editing line (ladder image list display).

Yes

Input the password at the manager's level in [Option] - [System] - [Input Password] menu.

System ladder is displayed in [Option] - [Ladder Section] - [System Ladder].

Editing operations such as parts addition, parts connecting, relay No. setting, etc.

No

Complete ladder diagram editing?

Yes


No

Complete Ladder Editor 32 for FS100.

Yes

Load the ladder program file to the FS100.

No

Store data.

Complete ladder diagram editing?

Yes

Compile.

Fig. 4-1 Ladder Editing Operation Flow
5 STARTING AND ENDING LADDER EDITOR FOR FS100

5.1 How to Start

To start up Ladder Editor for FS100, open the [Start] menu in the Windows tool bars, and select “Ladder Editor for FS100” from [Program] – [Motoman] – [Ladder Editor for FS100].

When this application is initially started up or when the [Manage type] is set to “Easy Mode”, the [Enter Password] dialog box for the Easy Mode (Fig. 5-1) appears. When the [Manage type] is set to “Standard Mode”, the [Enter Password] dialog box for the Standard Mode (Fig. 5-2) appears. (For details on managing user accounts, refer to “25 USER INFORMATION MANAGEMENT”.)

![Fig. 5-1 Enter Password Dialog Box for Easy Mode](image)

![Fig. 5-2 Enter Password Dialog Box for Standard Mode](image)
If the “Require Password to Start Ladder Editor” check box is cleared in the [User Manager] dialog box, these dialog boxes for inputting passwords do not appear. The “Default User Names and Password List” managed and stored by the software administrator describes the “Login Name” and “Password”. This list is included with the shipment. Input the password, and the “Startup” display for Ladder Editor for FS100 appears as shown in Fig. 5-3 appears.

Fig. 5-3 “Startup” Display
5.2 How to End

Selecting [File] – [Exit] in the Ladder Editor for FS100 menu can close the Ladder Editor for FS100.

![Exit Menu](image)

Fig. 5.4 Exit Menu
6 READING AND STORING EDITED LADDER FILES

6.1 Reading Ladder Data

To perform ladder editing, read in the ladder program to be edited by Ladder Editor for FS100.

The following one type of files can be edited by Ladder Editor for FS100:

- Ladder program file (text file)

[How to Operate]


![Open Dialog Box](image)

2. To read in a ladder program file, select the ladder program file and click the [Open] button.
6.2 Reading Several Ladder Files

The Ladder Editor for FS100 is an MDI (Multi Document Interface) application to read in several ladder program files simultaneously. To select the ladder program to be edited, select the file name displayed in the [Window] menu, or select the window with the targeted ladder program among overlapped windows by selecting [Window] - [Cascade].

In addition, the targeted ladder program can also be selected where several editing windows are displayed and overlapped by selecting [Window] – [Cascade] menu.

Fig. 6-2 “Editing Window Overlapped” Display
6.3 Storing Edited Data

When ladder editing is completed, store the information in a file. **Before storing, compile the data when a ladder was edited by Ladder Editor for FS100.** Unless compiled, data may not be stored completely.

**[How to Operate]**

2. Selecting [File] – [Save As] displays the [Save As] dialog box. Set an arbitrary file name to the data to be stored.

To store the file, the following two types of file forms are available, depending on the method used to read in a file.

**6.3.1 Storing when a Ladder Program File (CIOPRG.LST) is Open**

When a ladder program file is read in, only a ladder program file (text file) can be stored in an output file form.

**6.3.2 Storing a Ladder Program that is Being Edited**

A ladder program being edited cannot be stored if it has a detected error, even if compiled. The ladder program being edited can be stored as a work file. For details, refer to paragraph “23.6 Rough Draft File Forced Output Function”.
7 CREATING A LADDER DIAGRAM

To create a new ladder program, use the standard ladder program as the base for editing. The standard ladder program is supplied as a template.

[How to Operate]

1. Selecting [File] – [New] displays the dialog box shown in Fig. 7-1.

2. Select the template to be set and click the [Open] button.

Fig. 7-1  [Select standard ladder template] Dialog Box
8 EDITING A LADDER DIAGRAM

All ladder diagrams are edited in the “Basic” Display shown in Fig. 3-1.

8.1 Ladder Parts Specifications

The Ladder Editor for FS100 supports the ladder parts corresponding to the new ladder codes employed for the FS100.

For the details on such ladder parts, refer to the [Ladder Parts Specifications] of [Help] menu.

8.2 Selecting a Ladder Edited Line

A ladder diagram is edited in the “ladder editing” display, and the line to be displayed in the “ladder editing” display is selected in the “ladder preview” display (Fig. 8-1). In the “ladder preview” display, images of the ladder diagrams of all the lines can be viewed set in the current ladder section (either system section or user section).

![Ladder Editor screen with selected line](image)

**Fig. 8-1 “Ladder Preview” Display**
To refer to the ladder image of a line that is not displayed on the display, scroll using the scroll bar.
In the “ladder preview” display, right-click the mouse to select the line to be edited and the “ladder editing” display with the ladder diagram of the selected line will appear.

8.3 Adding New Ladder Parts

New ladder parts can be added when editing a ladder diagram.
Add ladder parts in the following manner.

[How to Operate]

1. **Enter the parts addition mode (select parts to be added).**
   
   Selecting [Tool] – [Add Instructions] displays the list of ladder parts to be added. Then select the ladder parts. Or select the parts to be added from the ladder parts tool bar (refer to “26.2.4 Ladder Parts Tool Bar”).

   **Example** Adding the ladder parts of the NC contact
   

2. **Paste new parts on the matrix to be added in the “ladder editing” display.**
   
   When the ladder parts to be added are determined, the mouse form changes in the “ladder editing” display. The selected ladder parts appear at the side of the mouse pointer. **Left-click** on the matrix location where the ladder parts are to be added.

![Fig. 8-2 Paste of Ladder Parts](image-url)
“????” may appear for the added ladder parts. This is because the relay No. or register No. is not set for these ladder parts, and it is not an error. Set the relay No. or register No.. For the setting of the relay Nos. or register Nos., refer to the paragraph “8.6 Setting Relay No., Register No. and Constants”.

8.4 Deleting Ladder Parts
Delete the ladder parts in the following manner.

[How to Operate]
1. Enter the parts deletion mode.
   Select [Tool] – [Edit Instructions] – [Delete Instructions], or select ✖ from the parts control tool bar (refer to “26.2.2 Parts Control Tool Bar”).

2. Select the ladder parts to be deleted in the “ladder editing” display.
   Left-click on the matrix location where the ladder parts are to be deleted in the “ladder editing” display.

8.5 Connecting and Disconnecting Lines between Ladder Parts
Ladder parts on a certain matrix are connected to ladder parts on another matrix with a line. The connection method of the line determines the ladder process. The following paragraph describes how to connect and disconnect the line between ladder parts.

8.5.1 Connecting with a Line
Connect ladder parts with a line in the following manner.

[How to Operate]
1. Left-click the mouse on the first ladder part.
2. While pressing the mouse, drag the mouse to the second ladder part.
3. Release the left button at the second ladder part.
Two parts are connected by a drag and drop operation.

**Fig. 8-3 Line Connection Process**

- **Ladder Parts Connection Terminals**

  Ladder parts have IN and OUT terminals. A connecting line connects the IN and OUT terminals. A drop and drag operation determines which are IN and which are OUT terminals and connects them automatically. However, when two connection ladder parts are placed vertically as shown in Fig. 8-4, the user must decide to connect the IN or OUT side.

**Fig. 8-4 When Parts are Placed Vertically**

In Fig. 8-5, the mouse pointer is dragged from the center of a ladder part and dropped on the IN side of the other part, to make the connecting line on the IN side.

Dropping on the IN side makes a line which connects to the IN side of the other ladder part. On the other hand, dropping on the OUT side makes a line which connects to the other OUT side.
8.5.2 Disconnecting Two Parts

Erase the line between ladder parts to disconnect them in the following manner.

[How to Operate]
1. Right-click the mouse on the first ladder part.
2. While pressing the mouse, drag the mouse to the second ladder part.
3. Release the right button at the second ladder part.

Two parts are disconnected by a right-click, drag and drop operation.

Fig. 8-6 Disconnection Process
8.6 Setting Relay No., Register No. and Constants

Relay No., register No. and constants can be set for each ladder parts. Set these values in the following manner.

[How to Operate]

1. Enter the set value input mode.
   
   Select [Tool] – [Edit Instruction] – [Edit Instruction Parameters.], or select from the parts control tool bar (refer to “26.2.2 Parts Control Tool Bar”).

2. Select the ladder parts to which the set values are input in the “ladder editing” display.
   
   Left-click the mouse on the ladder parts in the “ladder editing” display, and the “set value input” dialog box appears.

   ![Image of Input Value Dialog Box]

   Select type of set value.

   **Fig. 8-7 [Input Value] Dialog Box**

   Note: The number of setting items in the [Input Value] dialog box differs depending on the ladder parts.

3. Input the set values.
   
   Select the type of the set value in the combo box of the [Input Value] dialog box, and then input a value suitable for the type of the set value.
   
   Click the [OK] button to set the values.

8.6.1 Setting Values Using a Pop-up Menu

Set values can also be set in the following manner using a pop-up menu. The pop-up menu appears by right-clicking the mouse.
[How to Operate]

1. Right-click the mouse on the ladder parts to which the set values are input, and select the pop-up menu.

   Right-click the mouse on the ladder parts to which the set values are input in the “ladder editing” display, and the pop-up menu appears. Select the [Edit Instruction Parameters], and the [Input Value] dialog box appears.

2. Input the set values.

   Input the set values in the [Input Value] dialog box.

8.7 Inputting Relay No. and Register No. Names

Names can be set for the relay Nos. and register Nos. When editing name, a new name can be input or name information read from the external name file can be edited. Set the name for a relay No. or a register No. in the following manner.

[How to Operate]

1. Enter the name input mode.

   Select [Tool] – [Edit Instruction] – [Edit Labels and Comments], or select from the parts control tool bar (refer to “26.2.2 Parts Control Tool Bar”).

2. Select the ladder parts where the number of the name to be selected is set.

   Left-click the mouse on the ladder parts where the number of the name to be selected is set in the “ladder editing” display, and the [Edit Labels and Comments] dialog box appears.

   ![Fig. 8-8 [Edit Labels and Comments] Dialog Box](image)

   Fig. 8-8 [Edit Labels and Comments] Dialog Box
The relay No. or register No. appears in the No. selection list box as shown below.

Relay No. : #xxxxx, W#xxxxx  
Register No. : Mxxx  

Note: Some ladder parts have several relay Nos. or register Nos. In such a case, several numbers appear in the No. selection list box.

Verify that the targeted relay Nos. or register Nos. appear and are selected in the relay No. selection list box.

3. Set the name.
Two types of names, a short name and a long name can be used. They are treated as follows with Ladder Editor for FS100.

Short name : Appears overlapped on the relay No. or register No. of the ladder diagram in the “ladder editing” display. (Refer to “23.8 Switching Short Name Display/ Non-Display”.)

Long name : Appears in the column of OUT relay names in the “ladder editing” display, and in the row of output signal names in the “ladder preview” display.

When setting is completed, be sure to click the [Update] button. This button records the setting information.

8.7.1 Setting Names Using a Pop-up Menu
Names can be also set in the following manner using the pop-up menu.

[How to Operate]
1. Select the ladder parts where the relay No. or register No. of the name to be edited is set.
   Right-click the mouse on the ladder parts where the relay No. or register No. of the name to be edited is set in the “ladder editing” display, and the pop-up menu appears. Select the [Edit Labels and Comments], the [Edit Labels and Comments] dialog box appears.
2. **Edit the name.**

   Edit the displayed name for a relay No. or register No. in the [Edit Labels and Comments] dialog box.

### 8.8 Inserting Editing Matrix Row and Line

Even though new ladder parts are to be inserted immediately before the ladder parts that have already been set, there may be no matrix for insertion as shown in the following diagram (Fig. 8-9).

![Diagram of a ladder circuit with matrix](image)

**Fig. 8-9 When No Space for Matrix**

In this case, insert a line (or a row) to secure the matrix where the ladder parts are to be inserted.

#### 8.8.1 Inserting a Row

Insert a row in the following manner.

**[How to Operate]**

1. **Enter the row insertion mode.**
   
   Select [Tool] → [Edit Instructions] → [Edit Entire Row] → [Insert Row].

   Or select from the parts control tool bar (refer to “26.2.2 Parts Control Tool Bar”).

2. **Specify the matrix where a row is to be inserted.**

   Left-click the mouse on the matrix where a row is to be inserted.
Fig. 8-10 Result of Row Insertion

- **Row Insertion Disabled Pattern**

A row cannot be inserted if even one part exists in the column just before the last column on the right after the second line of the matrix in the “ladder editing” display.

Fig. 8-11 Disabled Row Insertion

### 8.8.2 Inserting a Line

Insert a line in the following manner.

**[How to Operate]**

1. Enter the line insertion mode.

2. Specify the matrix where a line is to be inserted.
   - Left-click the mouse on the matrix where a line is to be inserted.
**Line Insertion Disabled Pattern**

A line cannot be inserted if even one part exists in the lowest line of the matrix in the “ladder editing” display.
8.9 Deleting Editing Matrix Row and Line
Unnecessary rows or lines can be deleted.

8.9.1 Deleting a Row
Delete a row in the following manner.

[How to Operate]
1. Enter the row deletion mode.
   Or select \[ from the parts control tool bar (refer to “26.2.2 Parts Control Tool Bar”).

2. Specify the matrix where a row is to be deleted.
   Left-click the mouse on the matrix where a row is to be deleted.

   ![Fig. 8-14 Result of Row Deletion](image)

   Note: Deletion of a row deletes all the ladder parts that are set to the row to be deleted.

8.9.2 Deleting a Line
Delete a line in the following manner.

[How to Operate]
1. Enter the line deletion mode.
   Or select \[ from the parts control tool bar (refer to “26.2.2 Parts Control Tool Bar”).
2. Specify the matrix where a line is to be deleted.

Left-click the mouse on the matrix where a line is to be deleted.

![Fig. 8-15 Result of Line Deletion](image)

Note: Deletion of a line deletes all the ladder parts set to the line to be deleted.

8.10 Clearing Displays

The contents of the “ladder editing” display can be cleared when editing. This function is useful when the current display is to be reedited from the beginning.

**[How to Operate]**

Select [Edit] – [Clear Current Rung]. Or select from the parts control tool bar (refer to “26.2.2 Parts Control Tool Bar”).

32/88
9 INSERTING A NEW LINE

A new line is inserted into an arbitrary line. Since default values are set to the new line, change the values to the correct ladder information.

The new line is inserted into the next line of the line selected in the ladder preview display.

[How to Operate]

Select [Edit] – [Insert new Rung], or select  from the main tool bar (refer to “26.2.1 Main Tool Bar”).

![Fig. 9-1 Inserting New Line]
10 LINE OPERATION OF LADDER DIAGRAM

Be sure to select [Overwrite] or [Insert] for the contents edited in the “ladder editing” display before editing another line. Without this operation, the contents edited immediately before will be deleted. Ladder Editor for FS100 checks the ladder information that is being currently edited when another line appears. If the [Overwrite] or [Insert] is not selected, an editing confirmation message appears. (Refer to “23.7 Automatic Updating Function”.)

Fig. 10-1  [Auto Save Current Rung: Ask Before Saving Option] Dialog Box

Normally, the operator uses the menu or tool button to perform [Overwrite] or [Insert].

10.1 Changing an Edited Ladder Line

Overwrite the contents edited in the “ladder editing” display on the line currently being edited, in the following manner.

[How to Operate]

Select [Edit] – [Save Current Rung] – [Overwrite], or select from the main tool bar (refer to “26.2.1 Main Tool Bar”).

10.2 Inserting an Edited Ladder Line

Insert the contents edited in the “ladder editing” display into the next line of the line currently being edited, in the following manner. Therefore, the ladder data after the inserting line will be shifted backward.

[How to Operate]

Select [Edit] – [Save Current Rung] – [Insert], or select from the main tool bar (refer to “26.2.1 Main Tool Bar”).
11 CUTTING, COPYING AND PASTING LINES

11.1 Cutting a Ladder Diagram Line
Cut the line selected in the “ladder preview” display. The ladder information of the cut line can be pasted to another line by pressing [Paste Rung] or [Insert Cut/Copied Rung].

[How to Operate]
Select the line to be cut in the “ladder preview” display, and select [Edit] – [Cut Rung]. Or select from the main tool bar (refer to “26.2.1 Main Tool Bar”).

To select several lines simultaneously, hold down the [SHIFT] or [CTRL] key when selecting lines.

11.2 Copy a Ladder Diagram Line
Copy the line selected in the “ladder preview” display. The ladder information of the copied line can be pasted onto another line by pressing [Paste Rung] or [Insert Cut/Copied Rung].

[How to Operate]
Select the line to be copied in the “ladder preview” display. Then select [Edit] – [Copy Rung] menu. Or select from the main tool bar (refer to “26.2.1 Main Tool Bar”).

To select several lines simultaneously, hold down the [SHIFT] or [CTRL] key when selecting lines.

11.3 Pasting a Ladder Diagram Line
Paste the cut or copied contents of the line by pressing [Cut Rung] or [Copy Rung] over the line selected in the “ladder preview” display.
When several ladder list files are open simultaneously, the ladder diagram can be pasted onto another ladder list file.
[How to Operate]
Select the line to be pasted in the “ladder preview” display, and select [Edit] – [Paste Rung]. Or select 📏 from the main tool bar (refer to “26.2.1 Main Tool Bar”).

Note: This function is disabled if several lines were cut or copied by pressing [Cut Rung] or [Copy Rung] in the operation immediately before. After selecting only one line and pressing [Cut Rung] or [Copy Rung], try pasting again.

11.4 Inserting and Pasting a Ladder Diagram Line
Insert the cut or copied contents of the line into the line selected in the “ladder preview” display. Therefore, the ladder data after the inserting/pasting line will be shifted backward.
When several ladder list files are open simultaneously, the ladder diagram can be inserted and pasted onto another ladder list file.

[How to Operate]
Select the line to be inserted and pasted in the “ladder preview” display. Then select [Edit] – [Insert Cut/Copied Rung]. Or select 📏 from the main tool bar (refer to “26.2.1 Main Tool Bar”).
12 COMPILING EDITED CONTENTS

Be sure to compile the ladder information of each line after editing. Compiling performs final checking such as the relay No. overlapping check, etc. to load the information to the controller.

Notes 1: Without this operation, the edited data cannot be correctly stored.

Notes 2: Since compiling processes the system section and the user section of the ladder program, it is unnecessary to change to a system ladder or a user ladder.

[How to Operate]
Select [Tools] – [Check the Ladder], or select 📊 from the main tool bar (refer to “26.2.1 Main Tool Bar”).
13 PRINTING

13.1 Printing a Ladder Diagram

Print an image of a ladder diagram. For the ladder program to be printed, the line Nos. of other lines referring to the OUT terminal relay Nos. appear. The information of the reference lines appears as the system section and user section together.

[How to Operate]

13.2 Printing Relay No. Using List

Print the list of used relay Nos. and the line Nos. referring to each relay No. in a list. List information of the reference lines appears as the system section and user section together.

[How to Operate]


![Diagram of Relay No. List]

**Fig. 13-2 Printing Relay No. List**
13.3 Printing Register No. Using List

Print the list of used register Nos. and line Nos. referring to each register No. in a list. List information of the reference lines appears as the system section and user section together.

[How to Operate]


Fig. 13-3 Printing Register No. List
13.4 Printing Relay No. Use State

Print the relay No. use state in the “matrix” display.

[How to Operate]

Select [File] – [Print] – [Relay State Table].

Relay Nos. for the system section and user section appear together, indicated by the following symbols.

S: Relay Nos. used in a system section
U: Relay Nos. used in a user section
B: Relay Nos. used in both system and user sections

A relay No. in a matrix is regarded as YYYYYX when the vertical is “YYYYY” and the horizontal axis value is “X”.

![Fig. 13-4 Printing Relay No. Use State]
13.5 Printing User Alarms and User Messages

Print the lists of user alarms and user messages.

[How to Operate]


From 1 to 64 alarms can be registered. (Alarm information after No. 16 is omitted.)

User alarm section
Relay No. information

From 65 to 128 alarms can be registered. (Alarm information after No. 80 is omitted.)

User alarm display
Relay No. information

Fig. 13-5 Printing User Alarm List
Fig. 13-6 Printing User Message List
The following describes the items of printed information. User alarms and user messages can be printed. Since each display item is the same, this paragraph describes printing of the user alarm list as an example.

### 13.5.1 User Alarm System Section and User Section

A user alarm can be roughly classified as a system section that the system uses or a user section that the user can define freely. When printing, this information appears as the following word.

[User Alarm(****** Section)]

### 13.5.2 User Alarm Selection Relay No. Information

Relay No. information is displayed to help select a used user alarm. A user alarm is specified by turning the following six relays ON/OFF.

40130, 40131, 40132, 40133, 40134, 40135

When printing, this information appears as the following word.

[Type Selection Signal Relay No.]

When each relay No. is actually used in a code, the line No. appears.

### 13.5.3 User Alarm Display Relay No. Information

Relay No. information which becomes a trigger to help display a user alarm appears. The relay No. that becomes a display trigger is 40010.

When printing, this information appears with the following word.

[Request Signal Relay No.]

When each relay No. is actually used in a code, the line No. appears.
14 TRANSFERRING PRINTING INFORMATION TO A TEXT FILE

14.1 Transferring Ladder Diagrams to a Text File
Transfers an image of a ladder diagram to a text file.

[How to Operate]
Select [File] – [Save As Text Files] – [Ladder Diagram] – [System Section (or User Section)].

14.2 Transferring Used Relay No. Lists to a Text File
Transfers the lists of relay Nos. used and the line Nos. referring to each relay No. to a text file. The system section and the user section are transferred together in the list of reference lines.

[How to Operate]
Select [File] – [Save As Text Files] – [Relay List] – [System Section (or User Section)].

14.3 Transferring Used Register No. Lists to a Text File
Transfers the lists of register Nos. used and the line Nos. referring to each register No. to a text file. The system section and the user section are transferred together in the list of reference lines.

[How to Operate]
Select [File] – [Save As Text Files] – [Register List] – [System Section (or User Section)].

14.4 Transferring Relay No. Use State to a Text File
Transfers the relay number use state to the text file in a "matrix" display.

[How to Operate]
Select [File] – [Save As Text Files] – [Relay State Table].

14.5 Transferring User Alarms and User Messages to a Text File
Transfers the user alarms and user messages to a text file.

[How to Operate]
15 HEADER INFORMATION

15.1 Ladder Name and System Register Editing

Edit the ladder program names and system registers.

[How to Operate]

Select [Edit] – [Header Information], or select from the main tool bar (refer to “26.2.1 Main Tool Bar”).

![Header Information Dialog Box]

- **[Name] combo box**
  Selects a ladder name. Normally, select one from the list in the combo box. A name can be entered directly. **However, an improper name interrupts the loading to the controller.**

- **System registers**
  Sets the number of system registers.
16 USER ALARM AND USER MESSAGE INFORMATION

Edit the user alarms and user messages.

[How to Operate]
Select [Edit] – [Alarms and Messages], or select from the main tool bar (refer to “26.2.1 Main Tool Bar”).

Click the tag to select the user alarm and user message.

Language combo box
Each message has a first and a second languages. Select your desired language from the language combo box.

Editing area
Click the message to be edited in the message list, and the same message appears in the editing area. Edit the message in this area. When editing is completed, press the [Change] button.

16.1 User Alarm and User Message in System Section
If the user account level does not reach the management level, only the information in the user section appears in the message list. To display or edit the information in the system section, change the user account level. (Refer to “25 USER INFORMATION MANAGEMENT”.)
17 SYSTEM LADDERS AND USER LADDERS

A ladder program has a system ladder in the system section and a user ladder in the user section. Because the manipulator may not move properly unless the system section is correctly edited, general users cannot edit the system section as well as the XRC. General users can edit only in the user ladder section. (Contact your Yaskawa representative when editing in the system section of the ladder program is required.)
18 NAME FILE

18.1 What is a Name File?
Name file is a name information file to add a name to a relay No. or register No. used in the ladder program. (For the format of the name file, refer to “26.3 Name File Format”.)

18.2 Reading Name File
Name file is read in at either one of the following cases.
① When a ladder program file is open
② When a name file is read in from the menu

When a ladder program file is open, the name file is read in at the same time as the ladder program file. When a name file is read in from the menu, any existing name file can be read in whenever necessary.
The name file is saved in the same folder as the ladder program file.
(Even if a name file has not been prepared, the ladder program can still be edited. Refer to "18.2.1 Reading Name File Automatically (With Name File) ".)

18.2.1 Reading Name File Automatically (With Name File)
When reading in a ladder program file, Ladder Editor for FS100 automatically reads in the name file, too. The name file read in is determined by the ladder name of the ladder program used as a keyword (refer to “15.1 Ladder Name and System Register Editing”).
Example)
Ladder program name : ARCWELD
Read in file name : ARCWELD.NAM
18.2.2 Reading Name File Automatically (Without Name File)

If the desired name file is not available when automatically reading the name file, Ladder Editor for FS100 performs the operation in the following manner.

1. Selects a file suitable for the desired ladder program from the name template file prepared in default.
2. Copies the selected template file to the same directory as the ladder program file.
3. Reads in the copied template file as a name file.

In this case, Ladder Editor for FS100 refers to the ladder names to be read in to select the template file.

However, when the user changes the ladder name of the ladder program file, Ladder Editor for FS100 may not find any file name that coincides with the ladder name template file. In such a case, the [Select name template] dialog box (Fig. 18-1) appears.

![Select Standard Label Template](image)

**Fig. 18-1 [Select Name Template] Dialog Box**

Select the template suitable for the desired ladder program. Clicking the [Cancel] button stops the automatic reading of the name file.

The following shows the simple flowchart of the automatic reading.
18.3 Storing Name File

Store the edited name information by one of the following two methods.

① Stores it manually.

[How to Operate 1]

1. Select [File] – [Save Relay Label Files]. When the [Save As] dialog box appears, input an arbitrary name for the name file to store it. Normally, the file name is stored in the following format.

Ladder name. NAM

(Example)

ARCWELD. NAM

For the ladder names, refer to “15 HEADER INFORMATION”.

② Stores it automatically.

[How to Operate 2]

Setting the option stores the name file automatically. Refer to “23.3 Automatic Storing Function of Name File”.

51/88
18.4 Name Template File

Name template file is installed automatically when Ladder Editor for FS100 is setup. The following folder is created in the folder where the Ladder Editor for FS100 execution module exists, and the name template file is stored in this folder.

“Template”
19 RELAY/REGISTER NAME LIST DISPLAY FUNCTION

The relay name list display function and register name list display function can display the name list for all relay Nos. and register Nos.. All the data of the read-in name files can be cross referenced. This “list display” dialog box has the editing function. The name information of an arbitrary relay or register No. can be edited.

[How to Operate] ("Edit Relay Labels & Comments" Display)

Select [Edit] – [Relay Labels and Rung Comments]. The [Edit Relay Labels & Comments] dialog box appears as in Fig. 19-1. (Some machines take time to display it.)

![Fig. 19-1 [Edit Relay Labels & Comments] Dialog Box](image)

By selecting any desired relay No. from the list, the currently set data appears in the [No.], [Label] and [Comment] columns. Edit the data here. After editing, click the [Update] button to register the edited data.

If the [Label] and the [Comment] are similar for two or more relay Nos., change only the [No.], and then click the [Update] button. The name previously entered will remain. Because the names are similar, change only the characters that are different. The entire name does not have to be re-entered.
[How to Operate]("Edit Register Labels & Comments" Display)

Select [Edit] – [Register Labels]. The [Edit Register Labels & Comments] dialog box appears as in Fig. 19-2. (Some machines take time to display it.)

![Edit Register Labels & Comments Dialog Box](image)

**Fig. 19-2 [Edit Register Labels & Comments] Dialog Box**

Editing procedure is the same as that of “Edit Relay Labels & Comments” Display.

Normally, edit a relay or register name by opening the [Edit Relay Labels & Comments] dialog box on the ladder diagram. However, relay Nos. or register Nos. not used for ladder diagrams cannot be less of edited. These lists can be used to edit the names for all the relay or register Nos. regardless whether or not they are used on the ladder diagram.
20 LINE JUMP FUNCTION

The line jump function searches for and jumps to the line with the keyword.

20.1 Line No. Search Jump
This function jumps to the specified line No..

[How to Operate]
1. Select [Edit] – [Go to Rung], or select (black) from the search jump tool bar (refer to “26.2.3 Search Jump Tool Bar”).
When the dialog box shown in Fig. 20-1 appears, enter the line No. to jump and click the [OK] button.

![Fig. 20-1 “Enter a Rung No.” Dialog Box](image)

20.2 Parts Set Value Search Jump
This function searches for values such as relay Nos., register Nos., and constants set to the ladder parts, and then jumps to the line with the set values.

[How to Operate]
1. Select [Edit] – [Find Input Relays, Registers or Constants] – [Specify Parameter], or select (brown) from the search jump tool bar (refer to “26.2.3 Search Jump Tool Bar”).
2. When the dialog shown in Fig. 20-2 appears, enter the type of the value and the set value to be searched and click the [OK] button.

![Fig. 20-2 “Relay, Register or Constant” Dialog Box](image)
20.2.1 Previous/Next Search Jump

Previous search and next search functions can be used for searching for parts set values only.

[How to Operate]

For a backward search, select [Edit] – [Find Input Relays, Registers or Constants] – [Backward], or select (brown) from the search jump tool bar (refer to “26.2.3 Search Jump Tool Bar”). For forward search, select [Edit] – [Find Input Relays, Registers or Constants] – [Forward], or select (brown) from the search jump tool bar.

**Backward**

Backward search is a function to search for the set value in front of the current line (in the direction of smaller line No.).

**Forward**

Forward search is a function to search for the set value behind the current line (in the direction of greater line No.).

Unless new set values are entered by pressing [Edit] – [Find Input Relays, Registers or Constants] – [Backward search] or [Forward search], the set values to be searched for do not change.

This function can be used to easily know where and how the set values are used.

20.3 OUT Parts Relay No. Search Jump

The OUT parts relay No. search jump function searches only for the relay No. set to the OUT parts of the ladder parts and jumps there. Other ladder parts can not be searched for.

[How to Operate]

1. Select [Edit] – [Find Output Relays]. Or select (brown) from the search jump tool bar (refer to “26.2.3 Search Jump Tool Bar”).
2. When the dialog box shown in Fig. 20-3 appears, input the relay No. to be searched for and click the [OK] button.
This function can be used to analyze the conditions in which the relay used in the line turns ON retroactively.

20.4 History Jump
The history jump function stores the line jump functions used in the past as the history and easily returns to the previous jump source.

This function does not exist as a menu item; Only available as a tool bar button.

[How to Operate]
Select or from the search jump tool bar (refer to “26.2.3 Search Jump Tool Bar”).

Using this history jump button, you can freely move to the line registered in the jump history. Normally, this function is disabled. When jumps are performed, this function becomes enabled.

[Application]
An example of its most useful application is used together with “OUT parts relay No. search jump”. When searching for certain relay No. ON/OFF conditions using the “OUT parts relay No. search jump”, a search jump may also be performed in the further advanced lines for retroactive analyses. After completion of analysis, this history jump function can easily return to the previous line.
21 CROSS REFERENCE FUNCTION

21.1 Ladder Parts Set Value and Reference Line List Display Function

The ladder parts set value and reference line list display function displays on which line and for which ladder parts the specified set values are used.

[How to Operate]

1. Select [Tools] – [Instruction Use Table]. The dialog box shown in Fig. 21-1 appears.

![Fig. 21-1 Relay, Register or Constant Dialog Box]

2. After inputting the targeted set value type and the value, click the [OK] button. The [Instruction Use Table] dialog box appears.

![Fig. 21-2 Instruction Use Table Dialog Box]
[Relay, Register or Constant] (Reference Data) List Box
The list contains the set values to be searched for. Normally, there is only one item. However, since more than two items may appear occasionally, select one.

[Instruction Type] Tree
The tree consists of ladder parts. Selecting this tree item can limit the line Nos. displayed in the [Rang Containing Item] matrix. For example, selecting “STR” item displays only the line Nos. with the set values for “STR” parts.

[Rang Containing Item] Matrix
Displays the line Nos. referring to the set values selected in the [Relay, Register or Constant] (reference data) list box. The line No. appears in red if the detected line No. is within the system ladder area, and in blue if it is within the user ladder area.

[Application]
Set values in the ladder parts may be referenced by several other lines. In such cases, this function is useful to analyze where it is used or to know how it is used in other lines.

21.1.1 Line Jump from [Instruction Use Table] Dialog Box
The line jump from [Instruction Use Table] dialog box function can jump to an arbitrary line from the [Instruction Use Table] dialog box. As shown in Fig. 21-3, double-clicking the desired line No. on the [Rang Containing Item] matrix moves to the targeted line.
Fig. 21-3 Double-clicking Rungs Containing Item

Even if a line jump is performed by double-clicking, the [Instruction Use Table] dialog box does not disappear. Another jump to another line can be performed.

21.2 Function to Display the Relay No. Use Table and Register No. Use Table

This function displays which relay Nos. or register Nos. are used or not used in the ladder program that is being edited.

[How to Operate]

Select [Tools] → [Relay Use Table]. The dialog box shown in Fig. 21-4 appears.

Select [Tools] → [Register Use Table]. The dialog box shown in Fig. 21-5 appears.
Fig. 21-4 [Relay Use Table] Dialog Box

Fig. 21-5 [Register Use Table] Dialog Box
Use State Display Matrix

Relay Nos. (Register Nos.) used are displayed in the following colors:

- **Red**: Used in a system ladder.
- **Blue**: Used in a user ladder.
- **Purple**: Used in both system and user ladders.

In the matrix, the vertical axis displays the 10th or higher digits of the relay Nos. (Register Nos.) in units of 10, while the horizontal axis displays the 1st digit of the relay Nos. Therefore, in the case of the use state display matrix in Fig. 21-4, the left top matrix is the relay No. 40007.

Clicking the colored matrix displays the list of used line Nos. in the [Use in Rang] list box.

[1St Digit] Combo box

The use state appears in the “Use Table matrix” in units of 10000. Select the unit in the [1St Digit] combo box.

[Enter Number] Input Box

Inputting the relay No. (Register Nos.) in this input box and clicking the [Find] button displays the specified relay No. in the matrix display.

[Use in Rang] List Box

In the [Use in Rang] list box, the line information referring to the relay No. (Register Nos.) selected in the “use state display matrix” appears in the format shown in Fig. 21-6.

```
S:0008 - | | -
         Ladder parts
         Line No.
   S: System ladder
   U: User ladder
```

Fig. 21-6 Format of [Use in Rung] List Box

62/88
[Application]
When various relay Nos. are to be added or changed, this function is useful to use any unused relay Nos. (Register Nos.).

21.2.1 Line Jump from [Relay Use Table] Dialog Box
The line jump from [Relay Use Table] ([Register Use Table]) dialog box function can jump to an arbitrary line from the [Relay No. Use State] ([Register Use Table]) dialog box.
As shown in Fig. 21·7, double-clicking an item in the [Use in Rang] list box moves to the targeted line.

![Double-click the list item.]

**Fig. 21·7 Double-clicking Use Line List Item**
Even if a line jump is performed by double-clicking an item, the [Relay Use Table] dialog box does not disappear. Another jump to another line can be performed.
22 Mnemonic Display Function

Mnemonic display function allows displaying the ladder diagrams, which are selected in the “ladder preview” display, in mnemonic codes.

[How to Operate]
   The dialog box shown in Fig. 22-1 appears

22-1 Mnemonic Code Display

Note: The mnemonic code display does not show mnemonic codes which are being edited in the “ladder editing” display. It only shows the mnemonic codes of ladder diagrams which went through the process of [Edit] – [Save Current Rung] – [Overwrite] or [Edit] – [Save Current Rung] – [Insert].

22.1 Mnemonic Editing Function

If the following two conditions are fulfilled, mnemonic codes can be edited directly with the mnemonic code display as shown in Fig. 22-2 appears.

Condition 1) Mnemonic codes (error codes) cannot be analyzed with Ladder Editor for FS100.
Condition 2) The user account level is “Operator” and above.

Press [Update] when completing the editing.
Fig. 22-2 Mnemonic Editing Display

Note: If the edited mnemonic codes are recognized as correct codes after pressing [Update], the display screen returns to the normal mnemonic code display shown in Fig. 22-1, and the mnemonic codes become unable to be edited directly. When editing the codes again, display the mnemonic editing display on the screen.
23 OTHER SETTINGS

23.1 Setting Color
Set the colors of the information displayed in the “ladder editing” display.

[How to Operate]
1. Select [Option] – [Color Schme]. The dialog box shown in Fig. 23-1 appears.

![Fig. 23-1 (Color Schme) Dialog Box](image)

2. Select each item. The dialog box shown in Fig. 23-2 appears. Select and set any desired color.

![Fig. 23-2 (Color) Dialog Box](image)
23.2 Setting Font

Set the character font in the “ladder editing” display. Fonts can be set individually for the editing display and the preview display.

[How to Operate]


![Fig. 23-3 [Font] Dialog Box](image)

2. Select any desired font name, the font style and size. Then click the [OK] button.

23.3 Automatic Storing Function of Name File

Ladder Editor for FS100 has a function to store the name information automatically. Validating this function updates the name files automatically when storing the ladder information.
[How to Operate]
Refer to “23.9 File Settings”.

If a relay name or register name is changed with this function invalid, an alarm message appears when the “ladder editing” display is closed. Store the data by selecting [File] – [Save Relay Label File].

23.4 Automatic Rough Draft File Storing Function
If any interference occurs at editing and the application shuts down before storing the editing data, Ladder Editor for FS100 has a function to create a Rough Draft file (data file being edited) automatically.

[How to Operate]
Refer to “23.9 File Settings”.

With this function, the data in its current state is stored in a work file when a line is changed, inserted, or deleted in the “ladder editing” display. The stored file is saved with the following file name in the same folder as the ladder program file that is being edited.

Opened file name + “. TMP”

Notes: The data that is being edited in the “ladder editing” display is not stored.

23.5 Automatic Backup Function of the Read-in File (Original File)
When storing edited data, Ladder Editor for FS100 has a function to automatically back up the files before editing.
[How to Operate]

Refer to “23.9 File Settings”.

The automatic backup function is available for the following files:
- Ladder files (*.LST)
- Name files (*.NAM)

A file name of one of these backup files has an “_” (under score) after each file extension in the same folder as the original files:

   Relevant file name + extension + “_”

23.6 Rough Draft File Forced Output Function

Ladder Editor for FS100 stores only the ladder programs in which compiling and grammatical checks, etc. are completed normally. However, the procedure may be interrupted temporarily during editing. To store a ladder program that cannot be compiled during editing, it can be forcibly stored as a rough draft file.

[How to Operate]

1. Select [File] – [Save As Rough Draft].

2. When the [Save File] dialog box appears, use an arbitrary file name to store it.

23.7 Automatic Updating Function

If an attempt to move to another line is made without selecting [Line Alt] or [Line Insert] when the data has been edited in the “ladder editing” display, one can select whether the [Verification] dialog box appears or the line is to be updated automatically.

For automatic updating, select either [Overwrite Current Rung] or [Insert New Rung].
[How to Operate]

① Displaying the [Verification] dialog box

② Updating automatically

23.8 Switching Short Name Display/Non-Display
Relay names and register names have information for short names. A short name can appear along with the relay No. or register No. corresponding to it in the “ladder editing” display.

[How to Operate]
Select [View] – [Relay Labels] to place checkmark in the box.

Fig. 23-4 “Short Name” Display
23.9 File Settings

Select the Ladder Editor for FS100 optional functions.

[How to Operate]


![File Management Dialog Box](image)

**Fig. 23-5 [File Management] Dialog Box**

Auto Save Label File When Save Ladder File:
Automatically stores a name file at the same time as a ladder file.
Refer to “23.3 Automatic Storing Function of Name File”.

![File Management Dialog Box](image)
Auto Save Rough Draft if Ladder Editor Unexpectedly Closes:
Automatically stores the existing data as a temporary file before editing when overwriting a line or inserting a line.
Refer to “23.4 Automatic Rough Draft File Storing Function”.

Automatic backup of reading file:
Creates a backup of an original file when storing a ladder file or name file.
Refer to “23.5 Automatic Backup Function of Read-in Files (Original Files)”.

Specify Default Path for Opening Ladder Files:
Sets the default folder of the [Open] dialog box which appeared when [File] – [Open] were selected.
24 CHANGING USER ACCOUNT LEVEL

Change the user account level in the [Enter Password] dialog box (Fig. 24-1 or 24-2).

[How to Operate]

② Input the password.

When a [Enter Password] dialog box appears, input the log-in name or the password, and click the [OK] button.

![Fig. 24-1 [Enter Password] Dialog Box for Easy Mode](image)

![Fig. 24-2 [Enter Password] Dialog Box for Standard Mode](image)
25 USER INFORMATION MANAGEMENT

25.1 How to Manage User Account

Ladder Editor for FS100 manages the user accounts using the log-in names and the passwords to limit access to important data. The user accounts can be managed in “Easy Mode” and “Standard Mode”. The administrator of the user account levels can change the management mode. For strict user management, select “Standard Mode”. Table 25-1 describes the features of each management mode.

<table>
<thead>
<tr>
<th>Function</th>
<th>Easy Mode</th>
<th>Standard Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>User ID input at log-in</td>
<td>Not necessary. Only the password is necessary.</td>
<td>Necessary</td>
</tr>
<tr>
<td>Password input at application startup</td>
<td>Selectable</td>
<td>Necessary</td>
</tr>
<tr>
<td>Registration, modification, and deletion of user</td>
<td>Not available</td>
<td>Available</td>
</tr>
<tr>
<td>User account level when the password input is not necessary at the startup</td>
<td>Backup user</td>
<td>Necessary</td>
</tr>
</tbody>
</table>

Note: “Easy Mode” is the default management mode when Ladder Editor for FS100 is initially started up, and an [Enter Password] dialog box appears at the startup.
25.2 Difference Depending of the Account Levels

Table 25-2 shows the authorized functions for each account level.

<table>
<thead>
<tr>
<th>Account Level</th>
<th>1</th>
<th>2</th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Low</td>
<td>High</td>
<td></td>
</tr>
<tr>
<td>Classification</td>
<td>Backup operator</td>
<td>Operator</td>
<td>Administrator</td>
</tr>
<tr>
<td>Meaning</td>
<td>Mode for backup operator</td>
<td>Mode for general operator</td>
<td>Mode for administrator who sets up Ladder Editor for FS100 and is in charge of the maintenance of the system.</td>
</tr>
<tr>
<td>Authorized Functions</td>
<td>• Reading • Reading-in name files • Printing • Cross-referencing • Text output</td>
<td>• Reading • Read-in name files • Printing • Cross-referencing • Text output • Editing • Storing</td>
<td>• Reading • Read-in name files • Printing • Cross-referencing • Text output • Editing • Storing • Setting account management modes • Managing user information</td>
</tr>
</tbody>
</table>

The default users as shown in Table 25-3 have already been registered in the user accounts. Use the password assigned to each user.

Table 25-3 List of Default User Log-in Names

<table>
<thead>
<tr>
<th>Account Level Name</th>
<th>User Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>admin</td>
</tr>
<tr>
<td>Operator</td>
<td>user</td>
</tr>
<tr>
<td>Backup operator</td>
<td>backup</td>
</tr>
</tbody>
</table>

For each default user's password, refer to the “Default User Names and Password List” included with the shipment. The software administrator is responsible for storage and management of this list.

Any user other than the default users can be registered in the [User Manager] dialog box. (However, it is needed to perform the log-in for the user account at the “administrator” level.)
[How to Operate]

Select [Option] – [Access Control] – [User Manager], and the [User Manager] dialog box appears as shown in Fig. 25-1.

**Fig. 25-1 [User Manager] Dialog Box**

[Add User] button:
Adds a new user.
Refer to “25.3 Adding/Changing the User”.

[Edit User] button:
Changes the password or account level of the existing user. The default user information cannot be changed. (However, only password can be changed for the “user”.)
Refer to “25.3 Adding/Changing the User”.

[Delete User] button:
Deletes an existing user. The default users cannot be deleted.

Manage Type:
Select one of two methods to manage use accounts: “Standard Mode” and “Easy Mode”. Refer to “25.1 How to Manage User Accounts”.

“Require Password to Start Ladder Editor” check box:
Select this check box and the [Enter Password] dialog box will always appear the next time Ladder Editor for FS100 is started up.
25.3 Adding/Changing the User

Click the [Add User] or [Edit User] button, and the [Register new user] dialog box (Fig. 25-2) or the [Edit an exist user] dialog box (Fig. 25-3) appears.

**Fig. 25-2  [Register new user] Dialog Box**

**Fig. 25-3  [Edit an exist user] Dialog Box**

Input the [Login Name], [Password], [Confirm Password], and [Account Level], and then click the [OK] button. The log-in name cannot be changed in the [Edit an exist user] dialog box.
## 26.1 Description of Menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>• File</td>
<td>—</td>
</tr>
<tr>
<td>• New</td>
<td>Creates a new ladder program in default.</td>
</tr>
<tr>
<td>• Open</td>
<td>Opens an existing ladder program.</td>
</tr>
<tr>
<td>• Close</td>
<td>Closes the ladder program that is being edited.</td>
</tr>
<tr>
<td>• Save</td>
<td>Saves an overwritten ladder program in which compiling after editing is completed successfully. To save a ladder program that is being edited and cannot be compiled, use [File] · [Save As Rough Draft].</td>
</tr>
<tr>
<td>• Save As</td>
<td>Select the storage file name to save the ladder program in which compiling is completed successfully.</td>
</tr>
<tr>
<td>• Save As Rough Draft</td>
<td>Outputs a rough draft file. Can be selected when [Overwrite] or [Insert] is selected.</td>
</tr>
<tr>
<td>• Open Relay Label File</td>
<td>Reads in a name file for the ladder program that is being edited.</td>
</tr>
<tr>
<td>• Save Relay Label File</td>
<td>Saves the relay name information. Can be selected when a relay name is edited.</td>
</tr>
<tr>
<td>• Save As Text Files</td>
<td>—</td>
</tr>
<tr>
<td>• Ladder Diagram</td>
<td>—</td>
</tr>
<tr>
<td>User Section</td>
<td>Save file ladder diagram images of the user ladder.</td>
</tr>
<tr>
<td>System Section</td>
<td>Save file ladder diagram images of the system ladder.</td>
</tr>
<tr>
<td>• Relay List</td>
<td>—</td>
</tr>
<tr>
<td>User Section</td>
<td>Save file the relay No. list used in the user ladder.</td>
</tr>
<tr>
<td>System Section</td>
<td>Save file the relay No. list used in the system ladder.</td>
</tr>
<tr>
<td>• Register List</td>
<td>—</td>
</tr>
<tr>
<td>User Section</td>
<td>Save file the register No. list used in the user ladder.</td>
</tr>
<tr>
<td>System Section</td>
<td>Save file the register No. list used in the system ladder.</td>
</tr>
<tr>
<td>• Relay State Table</td>
<td>Save file the relay No. use state matrix.</td>
</tr>
<tr>
<td>• Alarms and Messages.</td>
<td>Save file user alarms and user messages.</td>
</tr>
<tr>
<td>• Print</td>
<td>—</td>
</tr>
<tr>
<td>• Ladder Diagram</td>
<td>—</td>
</tr>
<tr>
<td>Menu</td>
<td>Function</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>User Section</td>
<td>Prints ladder diagram images of the user ladder.</td>
</tr>
<tr>
<td>System Section</td>
<td>Prints ladder diagram images of the system ladder.</td>
</tr>
<tr>
<td>• Relay List</td>
<td>—</td>
</tr>
<tr>
<td>User Section</td>
<td>Prints the relay No. list used in the user ladder.</td>
</tr>
<tr>
<td>System Section</td>
<td>Prints the relay No. list used in the system ladder.</td>
</tr>
<tr>
<td>• Register List</td>
<td>—</td>
</tr>
<tr>
<td>User Section</td>
<td>Prints the register No. list used in the user ladder.</td>
</tr>
<tr>
<td>System Section</td>
<td>Prints the register No. list used in the system ladder.</td>
</tr>
<tr>
<td>• Relay State Table</td>
<td>Prints the relay No. use state matrix.</td>
</tr>
<tr>
<td>• Register State Table</td>
<td>• Prints the register No. use state matrix.</td>
</tr>
<tr>
<td>• Alarms and Messages</td>
<td>Prints user alarms and user messages.</td>
</tr>
<tr>
<td>• Print Preview</td>
<td>—</td>
</tr>
<tr>
<td>• Ladder Diagram</td>
<td>—</td>
</tr>
<tr>
<td>User Section</td>
<td>Previews ladder diagram images of the user ladder.</td>
</tr>
<tr>
<td>System Section</td>
<td>Previews ladder diagram images of the system ladder.</td>
</tr>
<tr>
<td>• Relay List</td>
<td>—</td>
</tr>
<tr>
<td>User Section</td>
<td>Previews the relay No. list used in the user ladder.</td>
</tr>
<tr>
<td>System Section</td>
<td>Previews the relay No. list used in the system ladder.</td>
</tr>
<tr>
<td>• Register List</td>
<td>—</td>
</tr>
<tr>
<td>User Section</td>
<td>Previews the register No. list used in the user ladder.</td>
</tr>
<tr>
<td>System Section</td>
<td>Previews the register No. list used in the system ladder.</td>
</tr>
<tr>
<td>• Relay State Table</td>
<td>Previews the relay No. use state matrix.</td>
</tr>
<tr>
<td>• Register State Table</td>
<td>Previews the register No. use state matrix.</td>
</tr>
<tr>
<td>• Alarms and Messages</td>
<td>Prints user alarms and user messages.</td>
</tr>
<tr>
<td>• Print Setup</td>
<td>Displays the “printer setting” dialog box.</td>
</tr>
<tr>
<td>• Exit</td>
<td>Closes Ladder Editor for FS100.</td>
</tr>
<tr>
<td>• Edit</td>
<td>—</td>
</tr>
<tr>
<td><strong>Menu</strong></td>
<td><strong>Function</strong></td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Undo</td>
<td>Returns the edited contents to the previous state.</td>
</tr>
<tr>
<td>Redo</td>
<td>Retries the operation that was returned to by [Return] operation.</td>
</tr>
<tr>
<td>Insert New Rung</td>
<td>Inserts a new line after the selected line.</td>
</tr>
<tr>
<td>Cut Rung</td>
<td>Deletes the ladder diagram information of the selected line.</td>
</tr>
<tr>
<td>Copy Rung</td>
<td>Copies the ladder diagram information of the selected line.</td>
</tr>
<tr>
<td>Paste Rung</td>
<td>Pastes the contents of [Cut Rang] or [Copy Rang] on the selected line. The ladder information that existed before pasting disappears.</td>
</tr>
<tr>
<td>Insert Cut</td>
<td>Inserts the contents of [Cut Rang] or [Copy Rang] into the selected line. All the lines after the selected line are moved backward.</td>
</tr>
<tr>
<td>Copy Rung</td>
<td>Copies the ladder diagram information of the selected line.</td>
</tr>
<tr>
<td>Save Current Rung</td>
<td>—</td>
</tr>
<tr>
<td>Overwrite</td>
<td>Overwrites and updates the ladder diagram information on the currently edited ladder diagram information for the currently displayed line.</td>
</tr>
<tr>
<td>Insert</td>
<td>Inserts the currently edited ladder diagram information to the next line of the currently displayed line.</td>
</tr>
<tr>
<td>Clear Current Rung</td>
<td>Clears the ladder diagram information of the currently displayed line.</td>
</tr>
<tr>
<td>Header Information</td>
<td>Displays the header information of the ladder program in operation.</td>
</tr>
<tr>
<td>Alarms and Messages</td>
<td>Displays the message information of the ladder program in operation.</td>
</tr>
<tr>
<td>Relay Labels and Rung Comments</td>
<td>Displays the relay name list.</td>
</tr>
<tr>
<td>Register Labels</td>
<td>Displays the register name list.</td>
</tr>
<tr>
<td>Find Input Relays, Registers or Constants</td>
<td>—</td>
</tr>
<tr>
<td>Specify Parameter</td>
<td>Searches for relay Nos., register Nos. or set constants.</td>
</tr>
<tr>
<td>Backward</td>
<td>Searches for set values in the direction of the smaller line No..</td>
</tr>
<tr>
<td>Forward</td>
<td>Searches for set values in the direction of the greater line Nos..</td>
</tr>
<tr>
<td>Find Output Relays</td>
<td>Searches for relay Nos. used in the OUT terminal.</td>
</tr>
<tr>
<td>Go to Rung</td>
<td>Searches for the specified line and jumps there.</td>
</tr>
<tr>
<td>Go to First Rung</td>
<td>Moves to the first line.</td>
</tr>
<tr>
<td>Go to Last Rung</td>
<td>Moves to the last line.</td>
</tr>
<tr>
<td>View</td>
<td>—</td>
</tr>
<tr>
<td>Main Toolbar</td>
<td>Switches between display/non-display of the tool bar.</td>
</tr>
<tr>
<td><strong>Menu</strong></td>
<td><strong>Function</strong></td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>• Navigation Toolbar</td>
<td>Switches between display/non-display of the search jump bar.</td>
</tr>
<tr>
<td>• Instruction Toolbar</td>
<td>Switches between display/non-display of the parts selection bar.</td>
</tr>
<tr>
<td>• Edit Toolbar</td>
<td>Switches between display/non-display of the parts control bar.</td>
</tr>
<tr>
<td>• Status Bar</td>
<td>Switches between display/non-display of the status bar.</td>
</tr>
<tr>
<td>• Relay Labels</td>
<td>Selects whether the relay short name is to be overlapped with the ladder diagram in the display.</td>
</tr>
<tr>
<td>• Output Relay User Table</td>
<td>Selects whether the line No. using each relay No. on the ladder diagram for the OUT terminal is to be overlapped with the parts in the display.</td>
</tr>
<tr>
<td>• Tools</td>
<td>—</td>
</tr>
<tr>
<td>• Check the Ladder</td>
<td>Compiles the currently displayed ladder program. Compiling checks for mistakes in the edited ladder program (such as overlapped relay Nos., measurement of processing time).</td>
</tr>
<tr>
<td>• Edit Instructions</td>
<td>—</td>
</tr>
<tr>
<td>Delete Instruction</td>
<td>Changes the edit mode to the deletion mode.</td>
</tr>
<tr>
<td>Edit Entire Row</td>
<td>—</td>
</tr>
<tr>
<td>Insert Row</td>
<td>Changes the edit mode to the line insertion mode.</td>
</tr>
<tr>
<td>Delete Row</td>
<td>Changes the edit mode to the line deletion mode.</td>
</tr>
<tr>
<td>Edit Entire Column</td>
<td>—</td>
</tr>
<tr>
<td>Insert Column</td>
<td>Changes the edit mode to the row insertion mode.</td>
</tr>
<tr>
<td>Delete Column</td>
<td>Changes the edit mode to the row deletion mode.</td>
</tr>
<tr>
<td>Edit Instruction Parameters</td>
<td>Changes the edit mode to the set value input mode.</td>
</tr>
<tr>
<td>Edit Labels and Comments</td>
<td>Changes the edit mode to the name input mode.</td>
</tr>
<tr>
<td>Quit the Editing Functions</td>
<td>Clears the edit mode.</td>
</tr>
<tr>
<td>• Add Instructions</td>
<td>—</td>
</tr>
<tr>
<td>STR</td>
<td>Changes to the set mode of STR parts.</td>
</tr>
<tr>
<td>STR·NOT</td>
<td>Changes to the setting mode of STR·NOT parts.</td>
</tr>
<tr>
<td>GRP</td>
<td>Changes to the setting mode of GRP parts.</td>
</tr>
<tr>
<td>TMR</td>
<td>Changes to the setting mode of TMR parts.</td>
</tr>
<tr>
<td>MLTMR</td>
<td>Changes to the setting mode of MLTMR parts.</td>
</tr>
<tr>
<td>Menu</td>
<td>Function</td>
</tr>
<tr>
<td>------</td>
<td>----------</td>
</tr>
<tr>
<td>CNT</td>
<td>Changes to the setting mode of CNT parts.</td>
</tr>
<tr>
<td>OUT</td>
<td>Changes to the setting mode of OUT parts.</td>
</tr>
<tr>
<td>ADD</td>
<td>Changes to the setting mode of ADD parts.</td>
</tr>
<tr>
<td>SUB</td>
<td>Changes to the setting mode of SUB parts.</td>
</tr>
<tr>
<td>MUL</td>
<td>Changes to the setting mode of MUL parts.</td>
</tr>
<tr>
<td>DIV</td>
<td>Changes to the setting mode of DIV parts.</td>
</tr>
<tr>
<td>MOD</td>
<td>Changing to the setting mode of MOD parts.</td>
</tr>
<tr>
<td>BIN</td>
<td>Changes to the setting mode of BIN parts.</td>
</tr>
<tr>
<td>BCD</td>
<td>Changes to the setting mode of BCD parts.</td>
</tr>
<tr>
<td>MOV</td>
<td>Changes to the setting mode of MOV parts.</td>
</tr>
<tr>
<td>WAND</td>
<td>Changes to the setting mode of WAND parts.</td>
</tr>
<tr>
<td>WOR</td>
<td>Changes to the setting mode of WOR parts.</td>
</tr>
<tr>
<td>WXOR</td>
<td>Changes to the setting mode of WXOR parts.</td>
</tr>
<tr>
<td>WNOT</td>
<td>Changes to the setting mode of WNOT parts.</td>
</tr>
<tr>
<td>SHL</td>
<td>Changes to the setting mode of SHL parts.</td>
</tr>
<tr>
<td>SHR</td>
<td>Changes to the setting mode of SHR parts.</td>
</tr>
<tr>
<td>ROL</td>
<td>Changes to the setting mode of ROL parts.</td>
</tr>
<tr>
<td>ROR</td>
<td>Changes to the setting mode of ROR parts.</td>
</tr>
<tr>
<td>PLF</td>
<td>Changes to the setting mode of PLF parts.</td>
</tr>
</tbody>
</table>

- **Instruction User Table** Displays the list of lines which uses specified set values (relay Nos., register Nos., constants).
- **Relay Use Table** Displays the relay No. use state matrix.
- **Register Use Table** Displays the register No. use state matrix.
- **Display Mnemonic** Displays the Mnemonic.
- **Option** —
- **Access Control** —
- **Enter Password** Displays the “password input” display. Needed to edit in the system section.
<table>
<thead>
<tr>
<th>Menu</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Manager</td>
<td>Displays the “user manager” dialog box.</td>
</tr>
<tr>
<td>Current Ladder Section</td>
<td>—</td>
</tr>
<tr>
<td>User Section</td>
<td>Changes a ladder to be edited into a ladder in the user section.</td>
</tr>
<tr>
<td>System Section</td>
<td>Changes a ladder to be edited into a ladder in the system section. Only users at the manager level can edit the ladders in the system section.</td>
</tr>
<tr>
<td>Color Scheme</td>
<td>Sets the graphic color displayed in the “ladder editing” display.</td>
</tr>
<tr>
<td>Font</td>
<td>—</td>
</tr>
<tr>
<td>Edit Window</td>
<td>Sets the character font displayed in the “ladder editing” display.</td>
</tr>
<tr>
<td>Preview Windows</td>
<td>Sets the character font displayed in the “ladder preview” display.</td>
</tr>
<tr>
<td>Auto Save Current Rung</td>
<td>—</td>
</tr>
<tr>
<td>Ask Before Saving</td>
<td>Detects modification to the ladder diagram when moving to another line during editing, and selects whether the message to verify modification is to be displayed or not.</td>
</tr>
<tr>
<td>Overwrite Current Rung</td>
<td>With [Verify at Editing] above OFF, detects modification to the ladder diagram when moving to another line, and overwrites and updates the current line automatically.</td>
</tr>
<tr>
<td>Insert New Rung</td>
<td>With [Verify at Editing] above OFF, detects modification to the ladder diagram when moving to another line, and inserts the current line automatically to the line to be jumped.</td>
</tr>
<tr>
<td>File Management</td>
<td>Display File Management Dialog.</td>
</tr>
<tr>
<td>Window</td>
<td>—</td>
</tr>
<tr>
<td>Cascade</td>
<td>Overlaps windows.</td>
</tr>
<tr>
<td>Tile</td>
<td>Displays windows side by side.</td>
</tr>
<tr>
<td>Arrange Icons</td>
<td>Arranges icons of iconized window.</td>
</tr>
<tr>
<td>HELP</td>
<td>—</td>
</tr>
<tr>
<td>Help Topics</td>
<td>Displays the contents of HELP.</td>
</tr>
<tr>
<td>Search Keyword</td>
<td>Displays the “keyword search” dialog box of HELP.</td>
</tr>
<tr>
<td>Using Help</td>
<td>Displays how to use HELP.</td>
</tr>
<tr>
<td>About Ladder Editor</td>
<td>Displays the version information.</td>
</tr>
</tbody>
</table>
## 26.2 Description of Tool Bars
### 26.2.1 Main Tool Bar

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
<th>Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>![File]</td>
<td>Creates a new ladder program file in default.</td>
<td>[File] · [New]</td>
</tr>
<tr>
<td>![File]</td>
<td>Opens an existing ladder program.</td>
<td>[File] · [Open]</td>
</tr>
<tr>
<td>![File]</td>
<td>Overwrites and saves a ladder program in which compiling after editing is completed successfully. To save a ladder program that is being edited and cannot be compiled, select [File] · [Save As Rough Draft].</td>
<td>[File] · [Save]</td>
</tr>
<tr>
<td>![Edit]</td>
<td>Deletes the ladder diagram information of the selected line.</td>
<td>[Edit] · [Cut Rung]</td>
</tr>
<tr>
<td>![Edit]</td>
<td>Copies the ladder diagram information of the selected line.</td>
<td>[Edit] · [Copy Rung]</td>
</tr>
<tr>
<td>![Edit]</td>
<td>Pastes the contents of [Cut Rung] or [Copy Rung] on the selected line. The ladder information that existed before pasting disappears.</td>
<td>[Edit] · [Paste Rung]</td>
</tr>
<tr>
<td>![Edit]</td>
<td>Inserts the contents of [Cut Rung] or [Copy Rung] into the selected line. All the lines after the selected line are moved backward.</td>
<td>[Edit] · [Insert Cut\Copied Rung]</td>
</tr>
<tr>
<td>![Edit]</td>
<td>Returns the edited contents to the previous state.</td>
<td>[Edit] · [Undo]</td>
</tr>
<tr>
<td>![Edit]</td>
<td>Retries the operation that was returned to by [Return].</td>
<td>[Edit] · [Redo]</td>
</tr>
<tr>
<td>![Edit]</td>
<td>Inserts a new line after the selected line.</td>
<td>[Edit] · [Insert new Rung]</td>
</tr>
<tr>
<td>![Edit]</td>
<td>Overwrites and updates the currently edited ladder diagram information for the currently displayed line.</td>
<td>[Edit] · [Save Current Rung] – [Overwrite]</td>
</tr>
<tr>
<td>![Edit]</td>
<td>Inserts the currently edited ladder diagram information to the next line of the currently displayed line.</td>
<td>[Edit] · [Save Current Rung] – [Insert]</td>
</tr>
<tr>
<td>![Tool]</td>
<td>Compiles the currently displayed ladder program. Compiling checks for mistakes in the edited ladder program (such as overlapped relay Nos., measurement of processing time).</td>
<td>[Tool] · [Check the Ladder]</td>
</tr>
<tr>
<td>![Tool]</td>
<td>Displays the list of lines which uses specified set values (relay Nos., register Nos., constants).</td>
<td>[Tool] · [Instruction Use Table]</td>
</tr>
<tr>
<td>![Edit]</td>
<td>Displays the header information of the ladder program in operation.</td>
<td>[Edit] · [Header Information]</td>
</tr>
<tr>
<td>![Edit]</td>
<td>Displays the message information of the ladder program in operation.</td>
<td>[Edit] · [Alarms and Messages]</td>
</tr>
<tr>
<td>![Option]</td>
<td>Changes a ladder to be edited into a ladder in the system section. Only users at the manager level can edit the ladders in the system section.</td>
<td>[Option] · [Current Ladder Section] · [System Section]</td>
</tr>
<tr>
<td>![Option]</td>
<td>Changes a ladder to be edited into a ladder in the user section.</td>
<td>[Option] · [Current Ladder Section] · [User Section]</td>
</tr>
<tr>
<td>![Help]</td>
<td>Displays the contents of HELP.</td>
<td>[Help] · [Help Topics]</td>
</tr>
</tbody>
</table>
### 26.2.2 Parts Control Tool Bar

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
<th>Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Changes the edit mode to the deletion mode.</td>
<td>[Tools] - [Edit Instructions] - [Delete Instructions]</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Changes the edit mode to the line insertion mode.</td>
<td>[Tools] - [Edit Instructions] - [Edit Entire Row] - [Insert Row]</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Changes the edit mode to the line deletion mode.</td>
<td>[Tools] - [Edit Instructions] - [Edit Entire Row] - [Delete Row]</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Changes the edit mode to the row insertion mode.</td>
<td>[Tools] - [Edit Instructions] - [Edit Entire Column] - [Insert Column]</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Changes the edit mode to the row deletion mode.</td>
<td>[Tools] - [Edit Instructions] - [Edit Entire Column] - [Delete Column]</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Changes the edit mode to the set value input mode.</td>
<td>[Tools] - [Edit Instructions] - [Edit &amp;Instruction Parameters]</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Changes the edit mode to the name input mode.</td>
<td>[Tools] - [Edit Instructions] - [Edit Labels and Comments]</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Clears the “ladder diagram information” display of the currently displayed line.</td>
<td>[Edit] - [Clear Current Rung]</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Clears the edit mode.</td>
<td>[Tools] - [Edit Instructions] - [Quit the Editing Functions]</td>
</tr>
</tbody>
</table>
### 26.2.3 Search Jump Tool Bar

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
<th>Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Button" /></td>
<td>Searches for relay Nos. used in the OUT terminal.</td>
<td>[Edit] → [Find &amp; Output Relays]</td>
</tr>
<tr>
<td><img src="image2.png" alt="Button" /></td>
<td>Searches for relay Nos., register Nos., or set constants.</td>
<td>[Edit] → [Find Input Relays, Registers or Constants] – [Specify Parameter]</td>
</tr>
<tr>
<td><img src="image3.png" alt="Button" /></td>
<td>Searches for set values in the direction of the smaller line Nos..</td>
<td>[Edit] → [Find Input Relays, Registers or Constants] – [Backward]</td>
</tr>
<tr>
<td><img src="image4.png" alt="Button" /></td>
<td>Searches for set values in the direction of the greater line Nos..</td>
<td>[Edit] → [Find Input Relays, Registers or Constants] – [Forward]</td>
</tr>
<tr>
<td><img src="image5.png" alt="Button" /></td>
<td>Searches for the specified line and jumps there.</td>
<td>[Edit] → [Go to Rung]</td>
</tr>
<tr>
<td><img src="image6.png" alt="Button" /></td>
<td>Moves to the first line.</td>
<td>[Edit] → [Go to First Rung]</td>
</tr>
<tr>
<td><img src="image7.png" alt="Button" /></td>
<td>Moves to the last line.</td>
<td>[Edit] → [Go to Next Rung]</td>
</tr>
<tr>
<td><img src="image8.png" alt="Button" /></td>
<td>Jumps backward in the jump history.</td>
<td></td>
</tr>
<tr>
<td><img src="image9.png" alt="Button" /></td>
<td>Jumps forward in the jump history.</td>
<td></td>
</tr>
</tbody>
</table>
### 26.2.4 Ladder Parts Tool Bar

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
<th>Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>[STR]</td>
<td>Changes to the setting mode of STR parts.</td>
<td>[Tools] [STR] - [Add Instructions]</td>
</tr>
<tr>
<td>[STR-NOT]</td>
<td>Changes to the setting mode of STR-NOT parts.</td>
<td>[Tools] [STR-NOT] - [Add Instructions]</td>
</tr>
<tr>
<td>[GRP]</td>
<td>Changes to the setting mode of GRP parts.</td>
<td>[Tools] [GRP] - [Add Instructions]</td>
</tr>
<tr>
<td>[TMR]</td>
<td>Changes to the setting mode of TMR parts.</td>
<td>[Tools] [TMR] - [Add Instructions]</td>
</tr>
<tr>
<td>[MLTMR]</td>
<td>Changes to the setting mode of MLTMR parts.</td>
<td>[Tools] [MLTMR] - [Add Instructions]</td>
</tr>
<tr>
<td>[CNT]</td>
<td>Changes to the setting mode of CNT parts.</td>
<td>[Tools] [CNT] - [Add Instructions]</td>
</tr>
<tr>
<td>[OUT]</td>
<td>Changes to the setting mode of OUT parts.</td>
<td>[Tools] [OUT] - [Add Instructions]</td>
</tr>
<tr>
<td>[ADD]</td>
<td>Changes to the setting mode of ADD parts.</td>
<td>[Tools] [ADD] - [Add Instructions]</td>
</tr>
<tr>
<td>[SUB]</td>
<td>Changes to the setting mode of SUB parts.</td>
<td>[Tools] [SUB] - [Add Instructions]</td>
</tr>
<tr>
<td>[MUL]</td>
<td>Changes to the setting mode of MUL parts.</td>
<td>[Tools] [MUL] - [Add Instructions]</td>
</tr>
<tr>
<td>[DIV]</td>
<td>Changes to the setting mode of DIV parts.</td>
<td>[Tools] [DIV] - [Add Instructions]</td>
</tr>
<tr>
<td>[MOD]</td>
<td>Changing to the setting mode of MOD parts.</td>
<td>[Tools] [MOD] - [Add Instructions]</td>
</tr>
<tr>
<td>[BIN]</td>
<td>Changes to the setting mode of BIN parts.</td>
<td>[Tools] [BIN] - [Add Instructions]</td>
</tr>
<tr>
<td>[BCD]</td>
<td>Changes to the setting mode of BCD parts.</td>
<td>[Tools] [BCD] - [Add Instructions]</td>
</tr>
<tr>
<td>[MOV]</td>
<td>Changes to the setting mode of MOV parts.</td>
<td>[Tools] [MOV] - [Add Instructions]</td>
</tr>
<tr>
<td>[WXOR]</td>
<td>Changes to the setting mode of WXOR parts.</td>
<td>[Tools] [WXOR] - [Add Instructions]</td>
</tr>
<tr>
<td>[WNOT]</td>
<td>Changes to the setting mode of WNOT parts.</td>
<td>[Tools] [WNOT] - [Add Instructions]</td>
</tr>
<tr>
<td>[SHL]</td>
<td>Changes to the setting mode of SHL parts.</td>
<td>[Tools] [SHL] - [Add Instructions]</td>
</tr>
<tr>
<td>[SHR]</td>
<td>Changes to the setting mode of SHR parts.</td>
<td>[Tools] [SHR] - [Add Instructions]</td>
</tr>
<tr>
<td>[ROL]</td>
<td>Changes to the setting mode of ROL parts.</td>
<td>[Tools] [ROL] - [Add Instructions]</td>
</tr>
<tr>
<td>[ROR]</td>
<td>Changes to the setting mode of ROR parts.</td>
<td>[Tools] [ROR] - [Add Instructions]</td>
</tr>
<tr>
<td>[PLS]</td>
<td>Changes to the setting mode of PLS parts.</td>
<td>[Tools] [PLS] - [Add Instructions]</td>
</tr>
<tr>
<td>[PLF]</td>
<td>Changes to the setting mode of PLF parts.</td>
<td>[Tools] [PLF] - [Add Instructions]</td>
</tr>
</tbody>
</table>
26.3 Name File Format

The following shows the format of a name file.

//TYPE:ARCWELD
///11280
ssssssss,LLLLLLLL
aaaaaaa,BBBBBBBB

\[\text{For eight items}\]

, A restart, arc off restart processing memory reset
 Restart, restart processing reset
 Inching, inching
 Retract, retract

//20010
, External start
, , Call master job
 , Alarm/error reset
 ,

\[\text{For eight items}\]

//REGISTER
M209=ssssssss,LLLLLLLLLL
M210=Aconfirm relay sticking,
 arc confirm relay sticking
M211=Arc shortageR,
 arc shortage (robot side)
M212=Power failure, welder malfunction
M213=Retract request, wire retract request

[Relay Name:]
Short name : Within 8 characters
Long name : Within 60 characters

[Register Name:]
M000 = Short name, long name
Short name : Within 8 characters
Long name : Within 60 characters
“M” must be added to the first character in the name.